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Getting to Know  
Microsoft Office Versions 
Cengage is proud to bring you the next edition of Microsoft Office. This 
edition was designed to provide a robust learning experience that is not 
dependent upon a specific version of Office.

Microsoft supports several versions of Office: 

•	Office	365: A cloud-based subscription service that delivers 
Microsoft’s most up-to-date, feature-rich, modern productivity tools 
direct to your device. There are variations of Office 365 for business, 
educational, and personal use. Office 365 offers extra online storage 
and cloud-connected features, as well as updates with the latest 
features, fixes, and security updates.

•	Office	2021: Microsoft’s “on-premises” version of the Office apps, 
available for both PCs and Macs, offered as a static, one-time 
purchase and outside of the subscription model. 

•	Office	Online: A free, simplified version of Office web applications 
(Word, Excel, PowerPoint, and OneNote) that facilitates creating and 
editing files collaboratively. 

Office 365 (the subscription model) and Office 2021 (the one-time pur-
chase model) had only slight differences between them at the time this 
content was developed. Over time, Office 365’s cloud interface will con-
tinuously update, offering new application features and functions, while 
Office 2021 will remain static. Therefore, your onscreen experience may 
differ from what you see in this product. For example, the more advanced 
features and functionalities covered in this product may not be available 
in Office Online or may have updated from what you see in Office 2021. 

For more information on the differences between Office 365, Office 2021, 
and Office Online, please visit the Microsoft Support site. 

Cengage is committed to providing high-quality learning solutions for 
you to gain the knowledge and skills that will empower you throughout 
your educational and professional careers.

Thank you for using our product, and we look forward to exploring the 
future of Microsoft Office with you! 
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Using SAM Projects  
and Textbook Projects
SAM Projects allow you to actively apply the skills you learned live in 
Microsoft Word, Excel, PowerPoint, or Access. Become a more productive 
student and use these skills throughout your career.

To complete SAM Textbook Projects, please follow these steps:

SAM Textbook Projects allow you to complete a project as you follow 
along with the steps in the textbook. As you read the module, look for 
icons that indicate when you should download  your SAM Start 
file(s) and when to upload  the final project file to SAM for grading.

Everything you need to complete this project is provided within SAM. 
You can launch the eBook directly from SAM, which will allow you to take 
notes, highlight, and create a custom study guide, or you can use a print 
textbook or your mobile app.  Download IOS or Download Android.

To get started, launch your SAM Project assignment from SAM, MindTap, 
or a link within your LMS.

Step 1: Download Files

	 •	 Click	the	“Download	All”	button	or	the	individual	links	to	download	
your Start File and Support File(s) (when available). You must use 
the SAM Start file. 

	 •	 Click	the	Instructions	link	to	launch	the	eBook	(or	use	the	print	
textbook or mobile app).

	 •	 Disregard	any	steps	in	the	textbook	that	ask	you	to	create	a	new	
file or to use a file from a location outside of SAM.  

	 •	 Look	for	the	SAM	Download	icon	  to begin working with your 
start file.

	 •	 Follow	the	module’s	step-by-step	instructions	until	you	reach	the	
SAM Upload icon .

	 •	 Save	and	close	the	file.

Using SAM Projects and Textbook ProjectsSAM-2
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Step 2: Save Work to SAM

	 •	 Ensure	you	rename	your	project	file	to	match	the	Expected	File	
Name.

	 •	 Upload	your	in-progress	or	completed	file	to	SAM.	You	can	down-
load the file to continue working or submit it for grading in the 
next step. 

Step 3: Submit for Grading 

	 •	 Upload	the	completed	file	to	SAM	for	immediate	feedback	and	to	
view the available Reports.

	 •	 The	Graded Summary Report provides a detailed list of project 
steps, your score, and feedback to aid you in revising and re-
submitting the project.

	 •	 The	Study Guide Report provides your score for each project 
step and links to the associated training and textbook pages.

	 •	 If	additional	attempts	are	allowed,	use	your	reports	to	assist	with	
revising and resubmitting your project.

	 •	 To	re-submit	the	project,	download	the	file	saved	in	step	2.	

	 •	 Edit,	save,	and	close	the	file,	then	re-upload	and	submit	it	again.	

For all other SAM Projects, please follow these steps:

To get started, launch your SAM Project assignment from SAM, MindTap, 
or a link within your LMS.

Step 1: Download Files

	 •	 Click	the	“Download	All”	button	or	the	individual	links	to	download	
your Instruction File, Start File, and Support File(s) (when  
available). You must use the SAM Start file.

	 •	 Open	the	Instruction	file	and	follow	the	step-by-step	instructions.	
Ensure	you	rename	your	project	file	to	match	the	Expected	File	
Name	(change	_1	to	_2	at	the	end	of	the	file	name).

Step 2: Save Work to SAM

	 •	 Upload	your	in-progress	or	completed	file	to	SAM.	You	can	down-
load the file to continue working or submit it for grading in the 
next step.
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Step 3: Submit for Grading

	 •	 Upload	the	completed	file	to	SAM	for	immediate	feedback	and	to	
view available Reports.

	 •	 The	Graded Summary Report provides a detailed list of project 
steps, your score, and feedback to aid you in revising and  
resubmitting the project.

	 •	 The	Study Guide Report provides your score for each project 
step and links to the associated training and textbook pages.

	 •	 If	additional	attempts	are	allowed,	use	your	reports	to	assist	with	
revising and resubmitting your project.

	 •	 To	re-submit	the	project,	download	the	file	saved	in	step	2.	

	 •	 Edit,	save,	and	close	the	file,	then	re-upload	and	submit	it	again.	

For	additional	tips	to	successfully	complete	your	SAM	Projects,	please	
view	our	Common	Student	Errors	Infographic.

Using SAM Projects and Textbook ProjectsSAM-4
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1Creating and 
Modifying a Flyer

What Is Word?
Microsoft Word, or Word, is a full-featured word processing app that allows you to 
create professional-looking documents and revise them easily. With Word, you can 
create business, academic, and personal documents, including flyers, research papers, 
letters, memos, resumes, reports, mailing labels, and newsletters.

Word has many features designed to simplify the production of documents and 
add visual appeal. Using Word, you easily can change the shape, size, and color of 
text. You also can include borders, shading, tables, pictures, charts, and other objects 
in documents. While you are typing, Word performs many tasks automatically. For 
example, Word detects and corrects spelling and grammar errors in several languages. 
Word’s thesaurus allows you to add variety and precision to your writing. In addition 
to formatting text as you type, such as headings, lists, fractions, borders, and web 
addresses, Word includes a great deal of predefined text and many predefined objects 
and document types. Word also provides tools that enable you to create webpages and 
save the webpages directly on a web server.

To illustrate the features of Word, this book presents a series of projects that 
use Word to create documents similar to those you will encounter in business and 
academic environments. 

Objectives
After completing this module, you will be able to:

• Start and exit Word

• Enter text in a Word document

• Adjust margins

• Check spelling and grammar as you 
work in a document

• Save a document

• Format text, paragraphs, and document 
elements

• Undo and redo commands or actions

• Insert and format a picture

• Add a page border

• Change document properties

• Open and close a document

• Correct errors and revise a document

• Cut, copy, and paste text

• Print a document

• Use Word Help
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Introduction
To convey a message or announcement to employees or staff members, campus or 
school students, or the community or public, you may want to create a flyer. You then 
can post the flyer in a location targeted to your intended audience, such as on an 
employee bulletin board or in an office cubicle, at a kiosk, or on a hallway wall. You 
may also see flyers on webpages, on social media, or in email messages.

Project: Flyer with a Picture
Businesses create flyers to gain attention for a message or an announcement. Flyers, 
which usually are a single page in length, are an inexpensive means of reaching an 
audience. Many flyers, however, go unnoticed because they are designed poorly.

The project in this module follows generally accepted design guidelines and uses 
Microsoft Word to create the flyer shown in Figure 1–1. This colorful, eye-catching flyer 
is intended to convey proper handwashing techniques to food service employees at a 
campus or school cafeteria. The flyer, which will be hung above every sink in the kitchen 
and restroom areas, contains a digital picture of an employee washing his hands. The 
headline on the flyer is large and colorful to draw attention into the text. The body copy 

Figure 1–1
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below the headline briefly describes the purpose of handwashing, along with a numbered 
list that highlights how to wash hands and a bulleted list that concisely describes when to 
wash hands. The signature line of the flyer identifies a website that employees can visit for 
additional handwashing tips. Some words in the flyer are in a different color or further 
emphasized so that they stand apart from the rest of the text on the flyer. Finally, the page 
border nicely frames and complements the contents of the flyer.

In this module, you will learn how to create the flyer shown in Figure 1–1. You 
will perform the following general tasks as you progress through this module:
 1. Start and use Word.
 2. Enter text in a document.
 3. Format the text in the flyer.

Starting and Using Word
To use Word, you must instruct the operating system (i.e., Windows) to start the app. 
The following sections start Word, discuss some elements of the Word window, and 
perform tasks to specify Word settings.

If you are using a computer or device to step through the project in this module 
and you want your screen to match the figures in this book, you should change your 
screen’s resolution to 1366 × 768.

 4. Insert and format a picture in the flyer.
 5. Enhance the layout of the flyer on the page.

6. Correct errors and revise text in the flyer.

BTW
Resolution
For information about how 
to change a computer’s 
resolution, search for ‘change 
resolution’ in your operating 
system’s help files. 

To Start Word and Create a Blank Document

The following steps, which assume Windows is running, start Word and create a blank document based 
on a typical installation. Why? You will use Word to create the flyer in this module. You may need to ask your 
instructor how to start Word on your computer or device.

1
•  Click the Start button on 

the Windows taskbar to display 
the Start menu.

What is a menu? 
A menu contains a list of related 
items, including commands, 
apps, programs, 
and folders. Each 
command is a menu 
item that performs 
a specific action, 
such as saving a file 
or obtaining help. A 
folder is a named 
location on a storage medium that 
usually contains related documents. 

• If necessary, scroll through the list 
of apps on the Start 
menu until the Word 
app name appears 
(Figure 1–2).

What if my Word app is in a folder? 
Click the appropriate folder name to display the contents of the folder.

Q
&

A
Q

&
A

Figure 1–2

Note: To help you locate screen 
elements that are referenced 
in the step instructions, such 
as buttons and commands, this 
book uses red boxes to point 
to these screen elements

Word app 
name

Start menu

scroll bar

scroll box

Windows  
taskbar

list of apps 
installed on 
computer 
appears on 
Start menu 
above Start 
button

Start button
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2
• Click Word on the Start menu to start Word and display the Word start screen (Figure 1–3).

Figure 1–3

Word start 
screen

list of recently opened 
documents — your list may 
differ

Blank document 
thumbnail, or 
miniature image

3
• Click the Blank document thumbnail on the Word start screen to create a blank document in the Word window 

(Figure 1–4).

• If the Word window is not maximized, click the Maximize button next to the Close button on the title bar to 
maximize the window.

Figure 1–4

Print Layout button 
is selected when you 
first install Word

Windows taskbar displays 
Word app button, 
indicating Word is running

Windows 
search 
box

blank 
document 
created 

Close button 
closes an 
open window

Maximize 
button changed 
to a Restore 
Down button 
because window 
is maximized

title bar
Word window

title of blank 
document is 
Document1

Word is running

list of predefined documents, 
or templates — your list may 
differ
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What is a maximized window? 
A maximized window fills the entire screen. When you maximize a window, the Maximize button changes to a 
Restore Down button. 

4
• If the Print Layout button is not selected, click it so that your screen layout matches Figure 1–4.

What is Print Layout view? 
The default (preset) view in Word is Print Layout view, which shows the document on an image of a sheet of 
paper in the document window. 

Other Ways

1. Type app name in Windows search box, click app name in results list 2. Double-click Word icon on desktop, if one is present

Q
&

A
Q

&
A

The Word Window
The Word window consists of a variety of components to make your work more 

efficient and documents more professional. These include the document window and 
several other elements, depending on the task you are performing: scroll bar(s), status 
bar, ribbon, Search box, Quick Access Toolbar, Mini toolbar, shortcut menus, KeyTips, 
and Microsoft Account area. Most of these are common to other Microsoft 365 apps; 
others are unique to Word. The following sections briefly describe these elements; 
others are discussed as they appear in the Word window.

You view or work with a document on the screen through a document window, 
which is a window within Word that displays all or part of an open document (Figure 1–5). 
In the document, the insertion point is a blinking vertical line that appears when you 
click in the document and indicates where new text, pictures, and other objects will be 
inserted. As you type, the insertion point moves to the right, and when you reach the end 
of a line, it moves down to the beginning of the next line. The pointer is a small symbol 
on the screen that becomes different shapes depending on the task you are performing 
in Word and the pointer’s location on the screen. You move the pointer with a pointing 
device, such as a mouse or touchpad. The pointer in Figure 1–5 is the shape of an I-beam.

Scroll Bar You use scroll bars, which appear at the right and bottom edges of the 
document window, to view documents that are too large to fit on the screen at once. 
At the right edge of the document window is a vertical scroll bar. If a document is too 
wide to fit in the document window, a horizontal scroll bar also appears at the bottom 
of the document window. On a scroll bar, the position of the scroll box reflects the 
location of the portion of the document that is displayed in the document window; you 
can drag the scroll box, or click above or below it, to scroll through or display different 
parts of the document in the document window. A scroll arrow is a small triangular up 
or down arrow that is located at each end of a scroll bar; you can click the scroll arrows 
to scroll through the document in small increments. 

Status Bar The status bar, located at the bottom of the document window above 
the Windows taskbar, presents information about the document, the progress of 
current tasks, and the status of certain commands and keys; it also provides controls 
for viewing the document, such as zoom controls. As you type text or perform certain 
commands, various indicators and buttons may appear on the status bar.

The left side of the status bar in Figure 1–5 shows the current page followed 
by the total number of pages in the document, the number of words in the document, 
and an icon to check spelling and grammar. The right side of the status bar includes 
buttons and controls you can use to change the view of a document and adjust the size 
of the displayed document.

BTW
The Word Window
The modules in this book 
begin with the Word window 
appearing as it did at the 
initial installation of the 
software. Your Word window 
may look different depending 
on your screen resolution and 
other Word settings.
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Ribbon The ribbon, which is a horizontal strip located near the top of the Word 
window below the title bar, is the control center in Word that contains tabs of grouped 
commands that you click to interact with Word (Figure 1–6a). Each tab contains a 
collection of groups, and each group contains related commands. The ribbon provides 
easy, central access to the tasks you perform while creating a document. 

When you start Word, the ribbon displays several main tabs, also called default 
or top-level tabs (i.e., File, Home, Insert, Draw, Design, Layout, References, Mailings, 
Review, View, and Help). (Note that depending on the type of computer or device you are 
using, the Draw tab may not appear.) The Home tab, also called the primary tab, contains 
the more frequently used commands. The tab currently displayed is called the active tab.

To display more of the document in the document window, some users prefer to 
minimize the ribbon, which hides the groups on the ribbon and displays only the main tabs 
(Figure 1–6b). To minimize the ribbon, click the ‘Collapse the Ribbon’ button or click the 
‘Ribbon Display Options’ button on the title bar and then click Show Tabs on the menu. To 
use commands on a minimized ribbon, sometimes called a simplified ribbon, click the tab 

BTW
Pointer
If you are using a touch 
screen, the pointer may not 
appear on the screen as you 
perform touch gestures. The 
pointer will reappear when 
you begin using the mouse. 

Figure 1–5
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that you wish to expand. To expand the ribbon, double-click a tab, click the ‘Pin the ribbon’ 
button on an expanded tab, or click the ‘Ribbon Display Options’ button on the title bar 
and then click ‘Show Tabs and Commands’ on the menu.

Each time you start Word, the ribbon appears the same way it did the last time 
you used Word. The modules in this book, however, begin with the ribbon appearing 
as it did at the initial installation of the software. 

In addition to the main tabs, Word displays other tabs, called contextual tabs, 
when you perform certain tasks or work with objects such as pictures or tables. If 
you insert a picture in the document, for example, the Picture Format tab appears 
(Figure 1–7). When you are finished working with the picture, the Picture Format 
tab disappears from the ribbon. Word determines when contextual tabs should 
appear and disappear based on tasks you perform. Some tasks involve more than one 
contextual tab. For example, when you work with tables, the Table Design tab and the 
Layout tab appear.

Items on the ribbon include 
buttons, boxes (text boxes, check 
boxes, etc.), and galleries (shown 
in Figure 1–7). A gallery is a set of 
choices, often graphical, arranged 
in a grid or in a list that you can 
browse through before making a 
selection. You can scroll through 
choices in an in-ribbon gallery 
by clicking the gallery’s scroll 
arrows. Or, you can click a gallery’s 
More button to view more gallery 
options on the screen at a time.

Some buttons and boxes 
have arrows that, when clicked, 
also display a gallery; others always 
cause a gallery to be displayed 
when clicked. Most galleries 
support Live Preview, which is a 
feature that allows you to point to 
a gallery choice and see its effect in 
the document — without actually 
selecting the choice (Figure 1–8).

Figure 1–6b

main tabs

minimized ribbon 

Figure 1–7

Figure 1–8
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Figure 1–9

image of 
clipboard 
helps to 
identify 
Paste 
button

pointer 
on 
Paste 
arrow ScreenTip 

for Paste 
arrow

Some commands on the ribbon display an image to help you 
remember their function. When you point to a command on the ribbon, 
all or part of the command glows in shades of gray, and a ScreenTip 
appears on the screen. A ScreenTip is a label that appears when you 
point to a button or other on-screen object, which may include the name, 
purpose, or keyboard shortcut for the object and a link to associated help 
topics, if any exist (Figure 1–9). 

Some groups on the ribbon have a small arrow in the lower-right 
corner, called a Dialog Box Launcher, that when clicked, displays 
a dialog box or opens a pane with additional options for the group 
(Figure 1–10). When presented with a dialog box, you make selections 

and must close the dialog box 
before returning to the document. 
A pane, in contrast to a dialog box, 
is a window that can remain open 
and visible while you work in the 
document and provides additional 
options.

Search Box The Search box, 
which appears on the title bar, is 
a text box that helps you to find a 
command in Word or access the 
Word Help system (Figure 1–11). 
As you enter text in the Search 
box, the word-wheeling feature 
displays search results that are 
refined as you type. For example, 
if you want to insert a picture in 
a document, you can type the text 
“insert picture” in the Search box 
and then select the appropriate 
command. 

Quick Access Toolbar The 
Quick Access Toolbar, located 
initially (by default) above the 
ribbon at the left edge of the title 
bar, is a customizable toolbar 
that contains buttons you can 
click to perform frequently 
used commands (shown in 
Figure 1–11). The commands on 
the Quick Access Toolbar always 

are available, regardless of the task you are performing. The Touch/Mouse Mode 
button on the Quick Access Toolbar allows you to switch between Touch mode and 
Mouse mode. If you primarily are using touch gestures, Touch mode will add more 
space between commands on menus and on the ribbon so that they are easier to tap. 
While touch gestures are convenient ways to interact with Word, not all features are 
supported when you are using Touch mode. If you are using a mouse, Mouse mode 
will not add the extra space between buttons and commands. The modules in this 
book show the screens in Mouse mode.

Figure 1–10

clicking Dialog 
Box Launcher in 
Clipboard group 
opens Clipboard 
pane

clicking Dialog Box 
Launcher in Font 
group displays 
Font dialog box

Figure 1–11

Quick Access 
Toolbar search text

search results

Search box

Touch/Mouse 
Mode button

‘Customize 
Quick Access 
Toolbar’ button

BTW
Mouse Mode
The figures in this book use 
Mouse mode. To switch 
to Mouse mode, click the 
‘Touch/Mouse Mode’ button 
on the Quick Access Toolbar 
and then click Mouse on the 
Touch/Mouse Mode menu. If 
you are using Touch mode, 
you might notice that the 
function or appearance of 
your touch screen in Word 
differs slightly from this 
module’s presentation. 

D1814_WD-mod01_ptg01_001-084.indd   8 01/10/21   5:07 PM

Copyright 2023 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).
Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



M
ic

ro
so

ft
 W

o
rd

 2
01

9 
10

 M
o

d
u

le

Creating and Modifying a Flyer   Word Module 1   WD 1-9

W
o

rd
 M

o
d

u
le

 1

Figure 1–13

Microsoft 
Account area

KeyTips appear when you 
press ALT on keyboard

You can add other commands to or delete commands from the Quick Access 
Toolbar so that it contains the commands you use most often. To do this, click the 
‘Customize Quick Access Toolbar’ button on the Quick Access Toolbar and then select 
the commands you want to add or remove. As you add commands to the Quick Access 
Toolbar, its length may interfere with the document title on the title bar. For this 
reason, Word provides an option of displaying the Quick Access Toolbar below the 
ribbon on the Quick Access Toolbar menu. 

Each time you start Word, the Quick Access Toolbar appears the same way it did 
the last time you used Word. The modules in this book, however, begin with the Quick 
Access Toolbar appearing as it did at the initial installation of the software. 

Mini Toolbar and Shortcut Menus The Mini toolbar, which appears next to 
selected text, contains the most frequently used text formatting commands (which are 
those commands related to changing the appearance of text in a document). If you do 
not use the Mini toolbar, it disappears from the screen. The buttons, arrows, and boxes 
on the Mini toolbar vary, depending on whether you are using Touch mode or Mouse 
mode. To use the Mini toolbar, move the pointer into the Mini toolbar.

All commands on the Mini toolbar 
also exist on the ribbon. The purpose of 
the Mini toolbar is to minimize hand or 
mouse movement. For example, if you 
want to use a command that currently is 
not displayed on the active tab, you can 
use the command on the Mini toolbar — 
instead of switching to a different tab to 
use the command.

A shortcut menu, which appears 
when you right-click an object, is a list of 
frequently used commands that relate to 
the right-clicked object. When you right-
click selected text, for example, a shortcut 
menu appears with commands related 
to text. If you right-click an item in the 
document window, Word displays both 
the Mini toolbar and a shortcut menu 
(Figure 1–12).

KeyTips If you prefer using the keyboard instead of the mouse, you can press 
ALT on the keyboard to display KeyTips, which are labels that appear over each 
tab and command on the ribbon (Figure 1–13). To select a tab or command using 
the keyboard, press the letter or number displayed in the KeyTip, which may cause 
additional KeyTips related to the selected command to appear. For example, to select 
the Bold button on the Home tab, press ALT, then press H, and then press 1. To 
remove the KeyTips from the screen, press ALT or ESC until all KeyTips disappear, 
or click anywhere in the Word window.

Microsoft Account Area In the 
Microsoft Account Area (shown in 
Figure 1–13), you can use the Sign 
in link to sign in to your Microsoft 
account. Once signed in, you will 
see your account information.

BTW
Turning Off the Mini 
Toolbar
If you do not want the 
Mini toolbar to appear, 
click File on the ribbon to 
open Backstage view, click 
Options in Backstage view, 
if necessary, click General 
(Options dialog box), remove 
the check mark from the 
‘Show Mini Toolbar on 
selection’ check box, and 
then click OK.

Mini 
toolbar

shortcut 
menu

commands on 
Mini toolbar are 
also on ribbon

Figure 1–12
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To Display a Different Tab on the Ribbon

When you start Word, the ribbon displays 11 main tabs: File, Home, Insert, Draw, Design, Layout, References, 
Mailings, Review, View, and Help. (Note that depending on the type of computer or device you are using, the Draw 
tab may not appear.) The tab currently displayed is called the active tab. To display a different tab on the ribbon, you 
click the tab. The following step displays the View tab, that is, makes it the active tab. Why? When working with 
Word, you may need to switch tabs to access other options for working with a document or to verify settings. 

1
• Click View on the ribbon to display the View tab (Figure 1–14).

Why did the groups on the ribbon change? 
When you switch from one tab to another on the ribbon, the groups on the ribbon change to show commands 
related to the selected tab. 

Q
&

A

2
• Verify that the Print Layout button (View tab | Views group) is selected. (If it is not selected, click it to ensure the 

screen is in Print Layout view.) 

• Verify that the zoom level is 100% on the status bar. (If it is not, click the 100% button (View tab | Zoom group) to 
set the zoom level to 100%.) 

• Verify that the Ruler check box (View tab | Show group) is not selected. (If it is selected, click it to remove the 
selection because you do not want the rulers to appear on the screen.)

 Experiment

• Click the other tabs on the ribbon to view their contents. When you are finished, click Home on the ribbon to 
display the Home tab.

• Verify that Normal (Home tab | Styles group) is selected in the Styles gallery (shown in Figure 1–5). (If it is not 
selected, click it so that your document uses the Normal style.)

What is the Normal style? 
When you create a document, Word formats the text using a particular style. The Normal style is the default style 
that is applied to all text when you start Word. 

• If you are using a mouse, verify that you are using Mouse mode so that your screens match the figures in this book 
by clicking the Touch/Mouse Mode button on the Quick Access Toolbar (shown in Figure 1–5) and then, if necessary, 

Q
&

A

Figure 1–14

Print Layout 
button 
selected

Ruler check 
box not 
selected

100% button 
sets zoom 
level to 100%

View tab 
selected

groups on ribbon change to 
show commands related to 
viewing document, because 
View tab now is active tab

Print Layout 
button 
selected

zoom level 
100% 

Views 
group

Show 
group

Zoom 
group

Touch/Mouse 
Mode button
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To Adjust the Margins

Word is preset to use standard 8.5-by-11-inch paper, with 1-inch top, bottom, left, and right margins. The 
flyer in this module uses .5-inch top, bottom, left, and right margins. Why? You would like more text to fit from 
left to right and top to bottom on the page.

When you change the default (preset) margin settings, the new margin settings affect every page in the 
document. If you wanted the margins to affect just a portion of the document, you would divide the document 
into sections (discussed in a later module), which enables you to specify different margin settings for each 
section. The following steps change margin settings.

1
• Click Layout on the 

ribbon to display the 
Layout tab.

• Click the Margins 
button (Layout 
tab | Page Setup 
group) to display 
the Margins gallery 
(Figure 1–15).

Other Ways

1.  Position pointer on margin boundary on ruler; when pointer changes to two-headed arrow, drag margin boundary on ruler

Figure 1–15

Page Setup 
group Layout tab

depending on previous 
margin usage, your 
gallery may not have 
this setting

1" top margin is visible 
in document above 
insertion point

insertion 
point

1" left margin is visible 
in document to left of 
insertion point

Custom Margins command 
displays Margins tab in 
Page Setup dialog box

Margins 
gallery

current 
margin 
setting

Narrow 
margin 
setting

Margins 
button

2
• Click Narrow in the Margins 

gallery to change the margins 
to the specified settings 
(Figure 1–16).

What if the margin settings I want 
are not in the Margins gallery? 
You can click Custom Margins in 
the Margins gallery and then enter 
your desired margin values in the 
top, bottom, left, and right boxes 
in the Page Setup dialog box. 
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Figure 1–16

.5" top margin is 
visible in document 
above insertion point

insertion 
point

.5" left margin is visible in 
document to left of insertion point

clicking Mouse on the menu (if your Quick Access Toolbar does not display the Touch/Mouse Mode button, click 
the Customize Quick Access Toolbar button on the Quick Access Toolbar and then click Touch/Mouse Mode on the 
menu to add the button to the Quick Access Toolbar).
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Entering Text in a Document
The first step in creating a document is to enter its text. With the projects in this book, 
you enter text by typing on the keyboard. By default, Word positions text you type 
at the left margin. In a later section of this module, you will learn how to format, or 
change the appearance of, the entered text.

BTW
Character Widths
Many word processing 
documents use variable 
character fonts, where some 
characters are wider than 
others; for example, the letter 
w is wider than the letter i.

To Type Text

To begin creating the flyer in this module, type the headline in the document window. Why? The headline 
is the first line of text in the flyer. The following steps type the first line of text in the document.

1
• Type   Wash Your Hands!   as the headline (Figure 1–17).

What if I make an error while typing? 
You can press BACKSPACE until you have deleted the text in 
error and then retype the text correctly. 

What is the purpose of the ‘Spelling and Grammar 
Check’ icon on the status bar? 
The ‘Spelling and Grammar Check’ icon displays either a 
check mark to indicate the entered text contains no spelling 
or grammar errors, or an X to indicate that it found potential 
errors. Word flags potential errors in the document with 
squiggly, dotted, or double underlines that appear in a 
variety of colors. Later in this module, you will learn how to 
fix or ignore flagged errors. 
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Figure 1–17

insertion point 
moves to the 
right as you type

text typed

pointer’s shape changes depending 
on task you are performing in Word 
and pointer’s location on screen

‘Spelling and Grammar Check’ icon 
contains a check mark, indicating the 
entered text contains no spelling or 
grammar errors

number of 
words in 
document

image of sheet of paper 
on screen because screen 
is in Print Layout view

2
• Press ENTER to move the insertion point to the beginning of the next line 

(Figure 1–18).

Why did blank space appear between the headline and the 
insertion point? 
Each time you press ENTER, Word creates a new paragraph and inserts 
blank space between the two paragraphs. Later in this module, you will 
learn how to increase and decrease the spacing between paragraphs. 
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Figure 1–18

insertion 
point moved 
to next line

blank space 
automatically 
inserted 
between 
paragraphs

How do you use the touch keyboard with a touch screen?
To display the on-screen touch keyboard, tap the Touch Keyboard button on the Windows taskbar. When finished using the 
touch keyboard, tap the X button on the touch keyboard to close the keyboard. 

Consider This
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To Change the Zoom to Page Width

The next step in creating this flyer is to enlarge the contents that appear on the screen. Why? You would 
like the text on the screen to be larger so that it is easier to read. The document currently displays at a zoom 
level of 100% (shown in Figure 1–14). With Word, you can change the zoom to page width, which zooms 
(enlarges or shrinks) the image of the sheet of paper on the screen so that it is the width of the Word window. 
The following step changes the zoom to page width.

1
• Click View on the ribbon to display the View tab.

• Click the Page Width button (View tab | Zoom group) to display the page the same width as the document window 
(Figure 1–19).

If I change the zoom, will the document print differently? 
Changing the zoom has no effect on the printed document. 

What are the other predefined zoom options? 
Through the View tab | Zoom group or the Zoom dialog box (Zoom button in Zoom group), you can zoom to one 
page (an entire single page appears in the document window), many pages (multiple pages appear at once in the 
document window), page width, text width, and a variety of set percentages. Whereas changing the zoom to page 
width places the edges of the page at the edges of the document window, changing the zoom to text width places 
the document contents at the edges of the document window. 

What if I wanted to change the Zoom back to 100%? 
You could click the 100% button (View tab | Zoom group) or drag the zoom slider until 100% appears on Zoom 
level button. 
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Other Ways

1.  Click Zoom button (View tab | Zoom group), click Page width (Zoom dialog box), click OK

Figure 1–19

View tab

Page Width 
button

100% 
button

Zoom 
group

Zoom 
button

document 
content displays 
at 157%

edge of mock piece of 
paper aligned with edge 
of document window

zoom percentage 
automatically calculated 
by Word appears on 
Zoom level button — your 
percentage may differ

Zoom slider
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To Display Formatting Marks

You may find it helpful to display formatting marks while working in a document. Why? Formatting 
marks indicate where in a document you pressed ENTER, SPACEBAR, and other nonprinting characters. A 
formatting mark is a nonprinting character that appears on the screen to indicate the ends of paragraphs, tabs, 
and other formatting elements. For example, the paragraph mark (¶) is a formatting mark that indicates where 
you pressed ENTER. A raised dot (·) shows where you pressed SPACEBAR. Formatting marks are discussed as 
they appear on the screen.

Depending on settings made during previous Word sessions, your Word screen already may display 
formatting marks (shown in Figure 1–20). The following step displays formatting marks, if they do not show 
already on the screen.

1
• Click Home on the ribbon to display the Home 

tab.

• If it is not selected already, click the ‘Show/
Hide ¶’ button (Home tab | Paragraph group) 
to display formatting marks on the screen 
(Figure 1–20).

What if I do not want formatting marks to 
show on the screen? 
You can hide them by clicking the ‘Show/Hide 
¶’ button (Home tab | Paragraph group) again. 
It is recommended that you display formatting 
marks so that you visually can identify when 
you press ENTER, SPACEBAR, and other keys 
associated with nonprinting characters. Most of 
the document windows presented in this book, 
therefore, show formatting marks. 
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Other Ways

1.  Press CTRL+SHIFT+*

Wordwrap
Wordwrap allows you to type words in a paragraph continually without pressing 

ENTER at the end of each line. As you type, if a word extends beyond the right 
margin, Word also automatically positions that word on the next line along with the 
insertion point.

Word creates a new paragraph each time you press ENTER. Thus, as you type 
text in the document window, do not press ENTER when the insertion point reaches 
the right margin. Instead, press ENTER only in these circumstances:

 1. To insert a blank line(s) in a document (as shown in a later set of steps)
 2. To begin a new paragraph
 3. To terminate a short line of text and advance to the next line

4. To respond to questions or prompts in Word dialog boxes, panes, and other  
on-screen objects

Figure 1–20

‘Show/Hide ¶’ 
button selected

Home tab 

raised dot between each 
word indicates SPACEBAR 
has been pressed

Paragraph 
group

paragraph mark at end of line 
indicates ENTER has been pressed

paragraph mark at 
end of document

BTW
Formatting Marks
With some fonts, the 
formatting marks will not 
be displayed properly on 
the screen. For example, the 
raised dot that signifies a 
blank space between words 
may be displayed behind a 
character instead of in the 
blank space, causing the 
characters to look incorrect.
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